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1. What is Stick-e-NotePad?

Random Information Manager XE "Random Information Manager"  (R.I.M.) XE "(RIM)" 
Stick-e-NotePad is a new innovative type of program called a Random Information Manager (R.I.M.). A Random Information Manager is a powerful new type of tool that helps you organize the hundreds of pieces of random but critical information you use on a daily basis. This information is typically all over your desk, office and monitor in the form of sticky notes, scraps of paper, and jottings on the back of notebooks, magazines & the like. Unfortunately, even though all this information is within arm’s reach, it’s usually not possible to find what you need as quickly as you’d like.

A R.I.M. gives you one place to store all of this information so you can reclaim your office and your desktop without fear or guilt of losing even 1 piece of vital data. In addition to reclaiming your desk & office, you’ll actually be able to find what you’re looking for even QUICKER than before. Not only will your office look more organized, but having your information in a Stick-e-NotePad Binder also lets you:

1. Effortlessly search everywhere for any text you’re looking for in  seconds, saving hours of thumbing through papers each week

2. Easily arrange information in NotePads, Notes & Lists for quick retrieval. Rearranging info already entered is as simple as dragging & dropping

· The Free form data entry, and color coding let the program tailor itself to your information as you enter it. There is no strict format you must follow. 

· Because the program isn’t rigidly structured, it can serve the BASIC needs of several other programs such as home inventory, daily journal, contact manager, etc... This lets you maintain all of your data in 1 place, and saves you the time and money in purchasing and learning several programs

Why is a R.I.M. Different?

Unlike contact managers, you can put ANY information in a R.I.M. Unlike word processors or spreadsheets, you’re 2 level index (NotePad Explorer) is always visible, giving each little piece of information a convenient “handle” for quick location and editing. Unlike spreadsheets, text is automatically wrapped, cells are automatically sized, a convenient checkbox is included, and cells are always in edit mode in Lists. Unlike conventional databases, there is NO programming or configuration involved.

Complete Filing System within each Binder

· Easily manage hundreds of pieces of info within a single file

· Easily share information between binders using drag & drop or the clipboard

· Share or e-mail the Binder as easily as any other document

InstantEdit XE "InstantEdit"  & AutoSave XE "AutoSave" 
· Notes/Lists are opened for editing as soon as they are selected

· Open another Note/List, or close the program, and all your changes are automatically saved 

Easy to Use:

· Adding a new NotePad, Note or List is a simple mouseclick

· Creating a new Binder is as easy as making a new document in your favorite word processor or spreadsheet program

Most Popular Uses XE "Popular Uses" 
· Hot Info Organizer XE "Hot Info Organizer" : Instead of covering your desk & monitor with Notes, and making it hard for you to work, put the Notes in a Binder. You won’t lose them, and you’ll be able to work more effectively without the clutter.

· PhoneCall Log: XE "PhoneCall Log\:"  Enter all of your phone calls into a Binder. Make a List for each day, and a List Item for each call. Check it off when it’s done. Now you have an instantly searchable log of ALL your calls for ANY text you wish.

· Issue Tracker: XE "Issue Tracker"  Track customer open issues, or progress on projects. Also great for Help Desk issues.

· Filing Cabinet Index XE "Filing Cabinet Index" : Make as many entries for a particular file as you wish.  File your papers, and use your index to “remember” where you put your files.

· Publishing Platform XE "Publishing Platform" : Because a free Read/Print only viewer is available to all for free, you can create & distribute Stick-e-NotePad Binders knowing your clients will have a way to view the information you are publishing.

· Hundreds of other home & office uses: Check out our 101+Uses.stk Binder included with the program for more ideas. Send us your suggestions!

2. Installing XE "Installing Stick-e-NotePad"  Stick-e-NotePad on your PC

We STRONGLY advise you to close ALL running programs before you continue with this installation. This will minimize the chances of any system files failing to be properly updated because they are in use. 

To close all programs, press Control + Alt + Delete ONCE. This will show a list of all programs currently running on your computer. These programs must be closed one at a time by selecting each program in the list, and then pressing the End Task button. Close ALL programs except Explorer, systray, and Setup for Stick-e-NotePad.

Known Installation Issue XE "Installation Issue, Known"  IMPORTANT: 

Due to an open issue with the installation program, during Installation, DO NOT minimize the installation program while it is running. It will cause the installation program to fail.

Windows NT Installations XE "Installations, Windows NT"  NOTE:

If you are installing the program on a Windows NT (4.0 SP3  or higher) system, it is advised that you have administrator's rights to the machine you are installing the software on, or have an administrator install the software. If you don't have administrator's rights, you should at least have the 

1. Permissions to add the program folder necessary to 

   copy the program to the hard disk,  

2. the rights to copy &/or update files in the 

   <WINDOWS\SYSTEM> directory, and 

3. the rights to read & write keys in the Registry.

Stick-e-NotePad & Stick-e-AlarmClock are 32 bit programs, and will NOT run on any Windows 3.11 or earlier 16 bit system. The programs will NOT run properly on Windows NT 4.0 systems without Microsoft Service Pack 3 installed. This service pack is available from Microsoft (www.microsoft.com) and should be installed BEFORE installing this program. 

SYSTEM REQUIREMENTS XE "SYSTEM REQUIREMENTS" :

In order to run Stick-e-NotePad/Stick-e-AlarmClock, you must have the minimum system configuration described below:

Minimum system requirements:

486 DX2-66 or compatible PC

16MB RAM for Windows 95/98, 24MB for Windows NT

30 Megs free Hard Disk Space (Approx.)

Windows 95/98 or Windows NT 4.0 SP3 or later

VGA (640x480 256 Color) Video

Mouse or other pointing device

Recommended minimum system Requirements:

Pentium 200MMX PC

32Megs RAM

SVGA (800x600 256 Color) Video

NOTICE TO SOFTWARE DEVELOPERS XE "DEVELOPERS, Important message" :

This program contains 3rd party commercial Active-X XE "Active-X"  components. These components are installed and registered in the <Windows\System> directory as recommended in Windows program guidelines, and only overwrite Active-X files on your system if they are OLDER versions. If you have special issues where components you are using in your development are installed in directories other than <Windows\System>, or you REQUIRE OLDER versions of certain 3rd party Active-X components for your development needs and don't want them updated, please contact us to discuss your configuration before installing the software, to avoid the possibility of disrupting your development environment.

To Begin the Installation:

To Install XE "Install, from CD"  from CD ROM

1.  Insert the CD-ROM into the drive.

2.  On most systems, the Installation should automatically begin. Follow the instructions on the screen

3.  If your CD-ROM drive doesn’t support “autorun” (Doesn’t start installation automatically), press the Windows “Start” Button, and then press Run…

4.  Type D:\setup.exe , where D is the drive letter of your CD-ROM drive, and press OK.

5.  Follow the instructions on the screen to complete the installation.

To Install XE "Install, from Floppy"  from 3.5” Floppy Disks

1.  Insert the diskette labeled Disk 1 into the floppy drive.

2.  Press the Windows “Start” Button, and click Run…

3.  Type A:\setup.exe  , where A is the drive letter of your floppy drive, and click OK.

4.  Follow the instructions on the screen to complete the installation.

To Install XE "Install, from Web"  from the Internet Downloaded File

1.  Press the Windows “Start” Button, and click Run…

2.  Press the Browse… button, and then locate & double click the file you downloaded (stick-e-notepad_setup.exe) to select it.

3.  Press OK, and the installation will begin.

4.  Follow the instructions on the screen to complete the installation

3. Overview XE "Overview, Program Structure"  of the Program Structure

Stick-e-NotePad/Stick-e-AlarmClock (separate programs)

Stick-e-NotePad and Stick-e-AlarmClock are 2 separate programs that make up your Stick-e-NotePad system. Even though they are separate programs, they work very closely together. 

Stick-e-NotePad manages your information, and lets you set Alarms. When you set an Alarm, you are actually telling Stick-e-AlarmClock when to pop up the reminder message for you. 

Stick-e-AlarmClock’s only responsibility is to pop up Alarms (reminder messages) when you ask it to. For this reason, Stick-e-AlarmClock must be running in order for your Alarms to pop up. You’ll know when Stick-e-AlarmClock is running because you will see a little picture of an Alarm Clock in your System Tray. (The System Tray is the area on your taskbar which contains the clock)

By making the programs independent, your Stick-e-AlarmClock can be running in the background, always ready to pop up your Alarms even if Stick-e-NotePad is not running.

MULTIPLE USER SUPPORT XE "MULTIPLE USER SUPPORT" 
Because more than 1 person may want to use Stick-e-NotePad on a particular PC, Stick-e-NotePad requires that you “Sign In” when you start the program, so it knows who you are. By signing in, Stick-e-NotePad will remember all of your preferences, where you left everything the last time you used the program, and start YOUR Stick-e-AlarmClock (unless you set a preference not to) with Alarms you have set. Your password protects the privacy of your Alarms and prevents others from changing your settings. 

You can have more than one Stick-e-NotePad open at once to view more than one Binder at the same time. You can not have more than one Alarm Clock running, since only one user can be logged in at a time. If you try to run a second Stick-e-AlarmClock while one is already running, the program will explain that it cannot start another instance.

Once you Sign In XE "Sign In"  to either Stick-e-NotePad or Stick-e-AlarmClock, you don’t have to sign in again. The two programs talk to each other, so if one is running, it will let the other know who you are as the program starts. If you would like to “Log Out”, or Sign In as a different user, go to the File menupad of either program, and select Log Off. This will close all open Stick-e-NotePads, and Stick-e-AlarmClock, and allow Sign In as a different user. Stick-e-NotePad will then set the preferences and Alarms of the user who Signs In.

If you are using the software on a system you know no one else is using, or, you use the system much more than anyone else, you can set a default user who will be automatically logged in when either program starts. This will eliminate the need for you to Sign In. Please note that in order for the default user to automatically be signed in, that account CANNOT be password protected XE "password" . If the default user’s account is password protected, the program will display the default user’s name automatically in the Sign In form, but you will have to supply a password to Sign in. 

*To set a default User XE "default User" , select the Administration menu item from the Tools menupad of your Stick-e-NotePad program. Then open the Program Settings Page.

**To remove a Sign In password (Only if one has already been set), you must Sign In as that user, and go to the System Settings 1 page of My Preferences menu item available from the Tools menupad. 

***The first account XE "first account"  created when either Stick-e-NotePad or Stick-e-AlarmClock are run for the first time is an Administrator’s account. An Administrator can change settings which affect all users of the program on the machine. Administrators have a menu item called Administration, available at the bottom of the Tools menu pad. This is the only difference between an Administrator and a regular user account. You can have as many Administrators accounts as you wish. 

4. Running the program for the first time (Step by Step)

Launching the program XE "Launching the program" 
The Stick-e-NotePad installation program creates shortcuts directly in your Programs group, in addition to creating a folder in the programs group. Either shortcut will run the Stick-e-NotePad or Stick-e-AlarmClock program. 

Creating the first User XE "first User, creating" 
When either Stick-e-Notepad or Stick-e-AlarmClock are run for the first time, the program will ask you to create the first user’s account. The name you specify here, along with the password, must be used to Sign In to this account. You can specify whether this account is the default account (see info above). This account will also be an Administrator account.
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Finally, you will be asked whether you want either Stick-e-NotePad, or Stick-e-AlarmClock to automatically be run when Windows starts (When you turn on your PC). By checking either option, that program will be started automatically when Windows starts. Note that selecting Stick-e-NotePad automatically checks Stick-e-AlarmClock, because, by default, Stick-e-NotePad automatically starts Stick-e-AlarmClock when a user Signs In.

*These settings (Default user, start programs at Windows StartUp) are Administrator’s settings, and apply for all users of the PC. They may be changed by any Administrator through the Administration form available from the Tools menupad.

**NOTE: Stick-e-NotePad tells Windows to automatically run it when Windows starts by using the Registry, NOT the StartUp group. It is recommended that if you want to change these settings, NOT to manually edit the Registry, but to simply change them through Stick-e-NotePad Administration.

FIRST SIGN IN XE "FIRST SIGN IN" 
After you create the first user’s account, your Stick-e-Alarm Clock and Stick-e-NotePad programs begin. Then, you should see a Welcome Screen XE "Welcome Screen" . The Welcome Screen gives you quick access to the most common tasks in the program. ALL items available on the Welcome Screen are also available through the main menu. You don’t have to use the Welcome screen, it is simply a convenience until you become familiar with the program.

Welcome Screen
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The Welcome screen will display each time you Sign In. You can stop the Welcome Screen from displaying when you Sign In by checking the box in the lower left corner of the form. You have your option of selecting a specific Binder, or the last Binder you opened to be automatically loaded instead of displaying the Welcome form. This option can be set on your StartUp Settings page of your User Preferences form. To open this form, select the menu item “My Preferences” from the Tools menupad.

While the Welcome form is only shown when the program starts, you can display it at any time after you start working by clicking on the "Help" menupad on the main form, and when it drops down, click on the "Welcome" menuitem. This form will probably be useful to you until you become comfortable with the main menu, and all the shortcuts which are available for most functions.

5. Getting Answers quickly & easily (Help XE "Help" )

Stick-e-NotePad offers several ways to get information about using the program, and to help you get your work done quickly and conveniently.

What 's This? help XE "What 's This? help" 

 XE "Help, What 's This? help" :

"What's This?"Help is available to you on ALL forms in the program. This is a useful system which allows you to get an explanation of what ANY item on a form does for you. You can access "What's This?" help by doing the following:

1. Clicking on the question mark (?) in the upper right hand corner of the form, then, after your mouse pointer turns to an arrow with a question mark, click on the item you have a question about, and a message will pop up to tell you what you need to know.
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or 2. You can also move your mouse over the area, and then press "Shift + F1" keys at the same time, and the same message will pop up as in # 1.

or 3. On the Main Form, because there is no question mark in the upper right hand corner, you can click the question mark on the toolbar, or drop the Help menupad down and select "What's This?" from the menu, and then click on the item. (You can also use the "Shift + F1" method mentioned in item # 2 as well)

To clear the explanation which pops up, click anywhere on the form, or press the "Escape" key, and the message will disappear.

Menu helptext XE "Menu helptext" 

 XE "Help, Menu helptext" :

Menu helptext is also available to you on the Main Form for EVERY main menu and context menu item. You only need to be aware, that as your mouse moves over each menu item which is displayed, a description of what that menu item does is displayed on the status bar at the bottom of the form. You don't have to do anything to view this information. It is displayed automatically.
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ToolTip text XE "ToolTip text" 

 XE "Help, ToolTip text" :

Tooltip Text is another helpful feature which shows you a description of what a button will do if pressed. All you need to do is move your mouse over the button, and the Tooltip Text will appear. Move your mouse away, and the Tooltip Text will disappear. This is not nearly as much information as you will see when you use "What's This?" help mentioned above, but it is a quick way to see what a button will do for you.
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Tutorial Binders XE "Tutorial Binders" 

 XE "Binders, Tutorial" 
Stick-e-Notepad offers 4 Binders you can open and review to help you see what you can do with the program. To open the Binders, select one of the 4 buttons on the welcome form in the Tutorial Binders section, OR, they are also available from the Help menu.
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Standard Help File XE "Help File" 
Stick-e-NotePad also has a standard help file as most Windows applications do. To open the Help file, drop down the Help menu pad on the main form, and select the Contents item.
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6. Stick-e-NotePad Basic Concepts XE "Stick-e-NotePad Basic Concepts" 

 XE "Basic Concepts" 

 XE "Concepts, Basic Stick-e-NotePad" 
Stick-e-NotePad Binder: 

[A Complete Filing System within each Document]

Each Stick-e-NotePad Binder is a single file on your disk. Just like a document or a spreadsheet is a file, and can be edited, copied, e-mailed or moved, so can a Stick-e-NotePad Binder file. This flexibility makes it extremely easy to share XE "share"  Binders with other people, and keep as many Binders as you wish for different types of information, or projects. 

A valuable advantage your Stick-e-NotePad Binder offers you is the ability to create a “Filing System” within a single document. A Binder can contain 1 or more NotePads, each of which can be named anything you want, up to 200 characters. Each NotePad can contain 1 or more Note or List pages. Each page can also be named anything you wish, up to 200 characters in length. Notes & Lists can also be color coded.
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Because Stick-e-NotePad Binders are as convenient to use as other documents or spreadsheets, you can easily share information with others. By copying any selection of Notes, Lists or Notepads from one Binder to another, you can create custom Binders from others who supply you with information. You can create a Binder only containing information you want to share, and post or e-mail that Binder. 

Security XE "Security" 
If you are worried about the security of your Binder, you can easily password XE "password"  protect a Binder &/or encrypt XE "encrypt"  it. Then, only the person with the password can open the Binder.  Passwords can be easily set or removed at any time, however, Encryption can only be set when the Binder is first created. 

If you have a Binder which IS encrypted, and you want to remove the encryption, create a new unencrypted Binder, and copy the contents of the encrypted Binder into the new empty unencrypted Binder. Delete the encrypted Binder, and rename the new Binder to the previously encrypted Binder. To encrypt a Binder which is NOT currently encrypted, follow a procedure similar to that above.

Sharing Binders XE "SHARING BINDERS"  on a Network: Issues

You can put Binder files on a network, and more than 1 person can work with them at a time. There are some issues to be aware of. The first person to open the Binder is able to read/write to the Binder. All users opening the Binder after that have Read Only privileges to the Binder. With Read Only privileges, you can still View, Copy, Search and Print data in a Binder. You can not edit information in a Binder with Read Only privileges. 

AUTOSAVE XE "AUTOSAVE"  and AUTOEDIT XE "AUTOEDIT" 
Unlike most programs, you don’t have to worry about opening each Note or List for editing, and then having to save or cancel your changes before moving on. Once a Binder is open,  as you click on each Note or List in the NotePad Explorer, or select it from the drop down combo, it is instantly displayed, and ready for your editing. As you make changes, they are instantly and automatically saved. 

MAIN FORM VIEW PREFERENCES XE "PREFERENCES" 
NotePad Explorer XE "NotePad Explorer" 
Your NotePad Explorer is a convenient way to view the contents of your Binder, and quickly get to the Note or List you want. You can place your NotePad Explorer above, below, to the right or the left of your working area. You can also hide your NotePad Explorer if you want more room to work. You can always navigate to another NotePad, Note or List using the drop down lists whether the NotePad Explorer is displayed or not.  
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Toolbars XE "Toolbars" 
You may also show, hide, dock or undock the 2 toolbars present on the main form. 

Status Bar XE "Status Bar" 
The StatusBar may also be displayed or hidden. Hiding the StatusBar will give you more room for working with your information. You may want to hide the StatusBar after you are familiar with the menu items. The StatusBar is where the menu help text for each menu item is displayed.

Tools for setting the appearance of the Main Form are located in the VIEW menu pad.

Main Form Font XE "Font, Main Form" 
The font for all areas of the main form may be set through “My Preferences” available from the toolbar or the “Tools” menu pad. Set the font you like, making it larger for better visibility, or smaller to fit more information on the screen.

NOTEPAD AND PAGE NAME DROP DOWN LISTS:

 XE "Note, Naming" 

 XE "Naming a Note" 

 XE "List, Naming" 

 XE "Naming a List" 
The drop down lists of NotePads and Pages contain the same information as the NotePad Explorer. The drop down lists of NotePads and Pages in a Binder offer you 2 key features:

Keypress Search

1.  A KEYPRESS SEARCH XE "KEYPRESS SEARCH"  similar to that used in Windows help files. As you type the name of the Notepad or page you are looking for while the list is dropped down, the closest match is automatically scrolled to and selected. This is great for long lists.

2.  If you type in the name of a NotePad or Page which does NOT exist while you are searching (while the list is dropped down) the program will automatically create it. 

NOTE: To edit the current NotePad or Page name, simply make your changes in the text area when the list is NOT dropped down. Your changes will immediately be saved, and will show up in the NotePad Explorer as they are made. 

Sort Order XE "Sort Order" 

 XE "Sorting Notes & Lists" 

 XE "Notes & Lists, Sorting" 
Notes & Lists can be sorted Alphabetically, from A to Z or Z to A, by Date/Time created ascending or descending, or by Color Priority. When Notes & Lists are sorted by Color Priority XE "Color Priority" , they are first grouped & arranged by color, then within the color, they are sorted alphabetically from A to Z.  The Sort Order setting is the same for the NotePad Explorer as it is for the Drop Down Lists of NotePads & Pages. For this reason, you must type the information you are searching for according to the sort order. 

NOTE: If items are sorted by color, typing the first letter in the color will automatically complete the word for you.

The sort order can be set from the drop down list on the toolbar, or from the View menu pad. The NotePad Explorer will also support a convenient feature found in Windows. By clicking on the header panel of a column in the Listview portion of the NotePad Explorer, the Pages will automatically be sorted by the value in that column. Clicking the column header again will reverse the sort order of Pages based on that column.

NAMING NOTEPADS, NOTES & LISTS XE "NAMING NOTEPADS, NOTES & LISTS" 
You can name NotePads, Notes and Lists whatever you want up to 200 characters. Notes or Lists can have the same name within a NotePad, but 2 NotePads CANNOT have the same name within the Binder. If you name a new or existing NotePad to the same name as an existing one, all the Pages of that NotePad will be added to the existing NotePad. The program will warn you of this and allow you to cancel the operation if you wish.  

NOTE: Stick-e-NotePad does not currently support “In Place editing” for NotePad & Page names. In place editing is the process of clicking on the item in the NotePad Explorer to begin the process of changing the name directly in the NotePad Explorer. To edit the name of a NotePad or Page, you must do so in the appropriate drop down combo box. (We do have plans to support in place editing in the future.)

Dragging & Dropping XE "Dragging & Dropping" 

 XE "Drag & Drop" 
Notes, Lists & NotePads can be dragged & dropped within a Binder, or between two Binders using Drag/Drop. When dragging & dropping, items can be 

·  XE "Drag & Drop, Copy" Copied: A duplicate of the item is placed in the target location, leaving the original in tact
· Cloned XE "Drag & Drop, Cloning" : A duplicate copy of the item is placed in the target location, however further changes to EITHER item show up in BOTH items.
· Moved XE "Drag & Drop, Moving" : The selected item is removed from its current location, and placed in the target location.
The default XE "Drag & drop, Default action"  drag/drop operation can be set from the toolbar, or the View menu pad. Regardless of the default Drag/drop operation, you can override it with keyboard modifications:

<Shift> will convert operation to MOVE

<Ctrl> will convert operation to COPY

<Ctrl> + <Shift> will convert operation to CLONE 

Stick-e-NotePad offers a unique option when dragging & dropping: A  XE "drag & Drop, Confirmation Delay" CONFIRMATION. Many times, the mouse is sensitive enough that you may begin a drag operation just by releasing the mouse button after making a selection. Unfortunately, drag/drop, once it has begun, cannot be stopped… until now. You have the option of setting a confirmation message on drag drop operations. (It is set by default, and can be turned off through My Preferences) When set, upon release of the mouse on a drop target, a confirmation message with a countdown is displayed. At that time, you can click to CANCEL or CONFIRM the operation, or simply wait the number of seconds you set, and the operation will continue automatically.

For additional information about Drag/Drop operations, see the next section.

NOTE: Right mouse Drag/Drop operations are currently NOT supported in this release, but we do have plans to include it in future releases.
BINDER HIERARCHY

A Stick-e-NotePad Binder is a document similar to a letter or a spreadsheet. It has a name, and exists in your computer as a file. It can contain as many NotePads as you wish.  Within each NotePad, you may add as many Stick-e-Note or Stick-e-List Pages as you wish. Stick-e-Lists are made up of List Items. 

This Hierarchy is helpful in understanding Drag/Drop XE "Drag & Drop"  & Copy/Paste operations. 

· Text can be pasted into a Note or List Item. We currently do not support Dragging & Dropping text.

· List Items can be pasted into Lists. List items can also be pasted into a Note, but the formatting will be  lost. We currently do not support Dragging & Dropping List Items.

· Notes can be Dragged/Dropped or pasted into NotePads. If you paste a Note into a Binder, it will be pasted into the NotePad it was originally from. This means that pasting a Note into the same Binder will make a copy of that Note in its NotePad. Pasting a Note from one Binder into another will create the NotePad AND place the Note in it. (Provided the NotePad name didn’t exist in the other Binder)

· Lists can be Dragged/Dropped or pasted into NotePads. If you paste a List into a Binder, it will be pasted into the NotePad it was originally from. This means that pasting a List into the same Binder will make a copy of that List in its NotePad. Pasting a List from one Binder into another will create the NotePad AND place the List in it. (Provided the NotePad name didn’t exist in the other Binder)

· NotePads can be Dragged/Dropped or pasted from one Binder to another. If a NotePad of the same name exists in the other Binder, all the Note Pages & List pages of the NotePad will be placed in the target NotePad. Although strictly speaking, it goes against the hierarchy, you can Drag/Drop or paste one NotePad into another. What that does is copies all the Note Pages & List pages from the source NotePad to the target NotePad.

NOTE: Currently, you cannot Drag/Drop a NotePad from the ListView (right side) of the NotePad Explorer into another NotePad in the ListView. This is simply a current limitation of the program. 

· Binders can be Dragged/Dropped or pasted into other Binders.

 XE "Clone" CLONES

Because you may want certain information to show up in more than 1 place, you can CLONE a Note or List. Cloning a Note or List makes an identical copy of the Note or List in a different NotePad. You can CLONE a Note or List in more than 1 NotePad. Changing any CLONE makes changes in ALL other CLONES of that Note or List. You can only CLONE a Note or List within a Binder. You CANNOT Clone a Note or List from one Binder to another. 
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 XE "Alarms" ALARMS

You can attach Alarms to Notes or Lists in a Binder in order to remind yourself of important or timely information. For added flexibility, you may attach as many Alarms to a particular Note or List as you wish. You can also set an Alarm for a particular day which is NOT attached to a Note or List by using the calendar in the “My Alarms” form. 
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Because a user’s Alarms are stored in their own user files, they are independent of a Binder. Several users can have Alarms set for Notes or Lists in a particular Binder, and they won’t be seen or conflict with each other because they aren’t stored in the Binder. Also, the Binder doesn’t have to be open for the user to have Alarms pop up which were set for a Note/List in that particular Binder. Your Stick-e-AlarmClock maintains ALL of your Alarms, and will even display them if Stick-e-NotePad isn’t running. (Stick-e-AlarmClock must be running, however)

My Alarms  XE "Alarms, Past" 

 XE "Alarms, Future" (Past & Future)

Alarms set to go off in the future can be viewed by month on the “Future Alarms” page of the “My Alarms” form. To view the “My Alarms” form, select that menu item from the “Tools” menu pad.

Alarms which already popped up can be viewed on the “Past Alarms page of the “My Alarms” form. To view the “My Alarms” form, select that menu item from the “Tools” menu pad.

[image: image18.png]4 BILL’s Alarm Log

Future Alams  Pst Alsms |

~Show sat Alam atached o List
@Bl C Undone C Dope || C Ascending @ Descendig || Octbils
Date/Time Done [Remindr Message [GoTo] | o NoePad | Curertiens

76 | 07Mar1959 0629 aM]_#% [meg InBinder.  Eilfiedtk

16 | 12Feb1999 1228 P ¥/ [ewLitTie T | || ReminerMessage

17 {12 Feb 19991227 PH_#7[HowListTte it | | [oetsits

16 {12 Feb1999 1200 PH] ¢/ |Ciossprocsssconmmrical Nate

15 {12 Feb1999 1200 PH]_1_|Cieae picue programmalNate

20 {12Feb-1959 11:00 A1 Crosspracess conmricalNate

21 [127eb 1959 11:00 AM|_[Benking Note

22 {[10Feb-1959 0400 PH]_1| Crossprocess conmuricalNate

25 [10Feb-1959 04:00 PH]_1| Cieale pictue programmalNate

24 [ 10Feb 19590323 PM]_1[message 7 Show on Alsm Printouts

Delete AllAlarms

Delete Selected Alaris)

I~ Done _Delete this Alam

GotoList

& Pindiams

B¢ Ciose




 [image: image19.png]4 BILL’s Alarm Log 2]

Euture Alams | Past Alsms |

Alams or
< Mach [P [«] 1sss ¥ 1999
Sun | Mon | Tue | wed | The | Fi | sat ||| Aame |Detats]
= [ 2 [ ¢ [ s
Alam Tme | Message
7 5 5w n [z 1 D 0350AM Folow up ftr s receiv
AoIPM 0217
W[5 (8 [7 (g [13 | D0345PM Fiing eminder agert
2 2oz % |z
% [mam [ [ [z |5

Addélam. | EdtAlsm. | Delete Alam

& inans..| B Lo





 XE "Search" 

 XE "Find" SEARCH

Searching for information is as easy as entering information in Stick-e-NotePad. Since you can enter any information in any order, the Search function lets you find text anywhere you may have typed it: In a NotePad, Note or List Name, or anywhere inside a Note or List. The Search function returns a set of found items, which you can preview, copy or print.
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USER  XE "Preferences" 

 XE "Options" 

 XE "Settings" PREFERENCES

You can set over 50 different preferences for configuring your Stick-e-NotePad and Stick-e-AlarmClock to work the way you want them to. In addition to automatically remembering where you left all forms you opened, and how you last left them, the settings you can review and adjust are under the “My Preferences” menu item from the Tools menupad. When you Sign In, all your settings are restored.
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CONVENIENT TOOLS

Calculator & Calendar XE "Calculator" 

 XE "Calendar" 
Stick-e-NotePad offers a convenient Calculator & Calendar, which are available simply by pressing the F8 key. After you perform your calculation, or find your date, you can press 1 button and have the value automatically inserted into your Note or List. You can also copy the date or calculation to the Windows Clipboard, and paste it into any other Windows program that supports pasting.
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PRINTING

 XE "Printing" 

 XE "Report Layouts" Printing in Stick-e-NotePad is EXTREMELY flexible and powerful. All reports are printed according to a Report Layout format. You can create and save as many Report Layouts as you wish. You can set the fonts for each item (field) printed, which information is printed, and which printer is used for each Report Layout. 

If you can select it in Stick-e-NotePad, chances are, you can print it. You can select multiple Notes/Lists in the Listview, 1 or more NotePads in the Listview (while you are exploring the Binder), any text within a single Note, any text within a List Item, or any selected List Items within a single List. You can even print out your Alarms.

 XE "Quick Printing" QuickPrinting is a feature also available in Stick-e-NotePad. If enabled, QuickPrinting Notes/Lists will immediately send the print job to the printer specified in the selected Report Layout for QuickPrinting. QuickPrinting can be turned on for Notes/Lists and NotePads through “My Preferences”. If turned on, jobs can be QuickPrinted by 

· Pressing the Print button above the Note/List name for QuickPrinting selected Notes/Lists in the Listview or 

· Pressing the Print button above the NotePad name drop down list to QuickPrint the current NotePad, or selected NotePads in the Listview of the NotePad Explorer (while you are exploring the Binder).

RECYCLE BIN

 XE "Recycle Bin" 

 XE "Undelete" 

 XE "Restore" When NotePads, Notes or Lists are deleted, they are actually placed in the Recycle Bin. (Similar to Windows) From the Recycle Bin, the Items can be restored or permanently destroyed. When an Item is deleted or destroyed in a Binder, it is done so for ALL users. Each Binder has its own Recycle Bin. When you delete an Item, it isn’t placed in your own recycle Bin, users don’t have a Recycle Bin, its placed and stored in the Binder’s Recycle Bin.

NOTE: If you are planning to distribute a Binder, and have “deleted” NotePads, Notes or Lists which you may not want to share, MAKE XE "Security"  SURE YOU EMPTY THE RECYCLE BIN BEFORE YOU DISTRIBUTE THE FILE!
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Limitations

 XE "Limitations" 

 XE "Restrictions" 

 XE "Pictures" Please be aware of the following:

· Currently, Notes & Lists are stored as TEXT ONLY. No Rich Text formatting is available. The font for the entire Note or List can be set for the main form through “My Preferences”, and through Report Layouts when printing the Note or List.

· OLE objects (pictures, etc…) cannot be stored in a Note or List

· A Note or List can contain up to 64,000 characters.

We are currently considering taking the steps to remove these restrictions. Let us know of their importance to you. Send your comments to:

comments@fusionpointtech.com

 XE "Tips & Tricks" Tips & Tricks

Here are some things you may find helpful in working with the program:

1.  XE "Sorting" Sorting: Notes/Lists can be sorted 3 ways in the program: Alphabetically, by Date/Time created, and by Color Priority. To arrange Notes/Lists in an order different than these, rename the Note/List by adding 0001, 0005, 0010 … to the beginning of the Note name. The notes will still be sorted “alphabetically”, but you’ll be able to set the sort order you want by using the numbers. At first, skip a few numbers between items. You may want to add items between the pages you currently have. That won’t be possible without a lot of renumbering if you don’t leave yourself some room.

2.  XE "Sorting" Sorting: Another trick for sorting. If you want to order items by date, placing the date in the Page name (for phone messages, diaries etc…) using a conventional date format won’t allow the proper sort order. The following dates will be sorted in the following order: 12/01/1999, 12/01/2000, 12/02/1999… Displaying dates in the form YYYY/MM/DD where YYYY is the year, MM is the month, and DD is the day, will allow dates to be correctly sorted “alphabetically.” Check out your User Preferences, but <Ctrl> + <Shift> + D will automatically give you a date stamp in this format. A similar situation exists for TIME. Time represented with AM/PM won’t sort properly, but Time using Military Time format will. <Ctrl> + <Shift> + T should give you a Military Time Stamp.

3.  XE "Search" 

 XE "Find" Searching: Stick-e-NotePad lets you search for ANY text, anywhere within a Binder. In most cases, this is a very powerful tool, however, there are cases where it can be TOO MUCH. Let’s say you want to track “repairs” made to your home or office. Repair would be a “keyword” or “Topic.” The problem here is that Repair is a very common word, and might appear in the text of many Notes you’re NOT interested in. There is a little feature, which may not seem very helpful at first glance, but can prove very useful: the “Match case” option of the Find utility. If you wanted the word REPAIR to act as a keyword, and to ignore it in other circumstances, place it at the top of the Note as follows:  “rEPAIR.” Now, when you want to search by keyword, type the keyword using the case shown, and check the “Match case” option. The search will only return items of matching keywords. This is only one example of a method you can use to take advantage of the power & features of Stick-e-NotePad to accomplish your information management needs. You are only limited by your imagination. 

7. Full Product & Free Viewer License Concept

 XE "View Only" 

 XE "Print Only" 

 XE "Distribute" We want to make sharing information as easy as possible for you. The Document based Binder concept is one step in that design. The other side to sharing information is having a program to view the Document (Binder). The full version of Stick-e-NotePad will let you view and edit your Binders or anyone else’s Binder documents, but what about all the people who don’t have the program? As a convenience to you, our full version license holders, we only distribute Stick-e-NotePad as a Trialware setup. This means that you can install the software on any machine you wish, and use the full version for 30 days. For those who wish to license the program, they simply contact us (Fusionpoint Technologies Corp @ 800-950-0525) with their signature code, and we can provide an unlock code. All other users who want to  try out the program, or after the 30 day trial, want to continue to use it as a  XE "Trial Version" READ ONLY viewer can do so. The program automatically CONVERTS itself to a Read Only Viewer after the 30 day trial. The Read Only Viewer will allow you to VIEW, COPY or PRINT information in Stick-e-NotePad Binders. Now full licensees have a way to distribute information to people who didn’t have or don’t own a retail license. 

NOTE:  XE "Registration" If you purchased a Retail License, you should have received a License Certificate and Serial #. In order to Register the software, and convert the trial version to your full retail version, you should run the Register/Unlock Wizard. That certificate is proof of your purchase, and you will use that certificate & Serial # in place of a credit card to Register your software.

8. Common Keyboard Shortcuts

Sorted by Shortcut

Ctrl + X
Cut to Windows clipboard

Ctrl + C
Copy to Windows clipboard

Ctrl + V
Paste from Windows clipboard

Ctrl + A
Select All

Ctrl + Z
Undo last action

Ctrl + I
Copy to NotePad

Ctrl + H
Clone to NotePad

Ctrl + M
Move to NotePad

Ctrl + D
Insert Date stamp

Ctrl + T
Insert Time stamp

Ctrl + F
Find text

Ctrl + R
Set Alarm for Note/List

Ctrl + U
Recycle Bin

Ctrl + E
Show/Hide NotePad Explorer

Ctrl + P
Print

Shift + F6
Print Alarms

Ctrl + O 
Open other Binder

Ctrl + B
Create Binder

Ctrl + J
Create NotePad

Ctrl + N
Create Note

Ctrl + L
Create List

Ctrl + K
Goto NotePad

Ctrl + G
Goto Note/List

F3
Insert List Item

F4
Append List Item

F5
Delete List Item

F6
My Alarms

F8
Calculator

F9
Calendar

Ctrl + Alt + Y
Set Current Note/List Yellow

Ctrl + Alt + G
Set Current Note/List Green

Ctrl + Alt + B
Set Current Note/List Blue

Ctrl + Alt + P
Set Current Note/List Pink

Ctrl + Alt + W
Set Current Note/List White

Alt + Shift + Home
First NotePad

Alt + Shift + End
Last NotePad

Alt + Shift + PageUp
Previous NotePad

Alt + Shift + PageDn
Next NotePad

Alt + Home
First Note/List

Alt + End
Last Note/List

Alt + PageUp
Previous Note/List

Alt + PageDn
Next  Note/List




hold <Ctrl> key
Drag/Drop Copy

hold <Ctrl> + <Shift> keys
Drag/Drop Clone

hold <Shift> key
Drag/Drop Move




Alt
Activate program menu

Alt + <Space>
Activate system menu

F1
Help

Shift + F1
Context sensitive help

Shift + F10 (or Windows Menu key)
Context Sensitive menu

Alt + Enter
Properties

Shortcuts sorted by action

Activate program menu
Alt

Activate system menu
Alt + <Space>

Append List Item
F4

Calculator
F8

Calendar
F9

Clone to NotePad
Ctrl + H

Context sensitive help
Shift + F1

Context Sensitive menu
Shift + F10 (or Windows Menu key)

Copy to NotePad
Ctrl + I

Copy to Windows clipboard
Ctrl + C

Create Binder
Ctrl + B

Create List
Ctrl + L

Create Note
Ctrl + N

Create NotePad
Ctrl + J

Current Note Blue
Ctrl + Alt + B

Current Note Green
Ctrl + Alt + G

Current Note Pink
Ctrl + Alt + P

Current Note White
Ctrl + Alt + W

Current Note Yellow
Ctrl + Alt + Y

Cut to Windows clipboard
Ctrl + X

Delete List Item
F5

Drag/Drop Clone
hold <Ctrl> + <Shift> keys

Drag/Drop Copy
hold <Ctrl> key

Drag/Drop Move
hold <Shift> key

Find text
Ctrl + F

First Note/List
Alt + Home

First NotePad
Alt + Shift + Home

Goto Note/List
Ctrl + G

Goto NotePad
Ctrl + K

Help
F1

Insert Date stamp
Ctrl + D

Insert List Item
F3

Insert Time stamp
Ctrl + T

Last Note/List
Alt + End

Last NotePad
Alt + Shift + End

Move to NotePad
Ctrl + M

My Alarms
F6

Next  Note/List
Alt + PageDn

Next NotePad
Alt + Shift + PageDn

Open other Binder
Ctrl + O 

Paste from Windows clipboard
Ctrl + V

Previous Note/List
Alt + PageUp

Previous NotePad
Alt + Shift + PageUp

Print
Ctrl + P

Print Alarms
Shift + F6

Properties
Alt + Enter

Recycle Bin
Ctrl + U

Select All
Ctrl + A

Set Alarm for Note/List
Ctrl + R

Show/Hide NotePad Explorer
Ctrl + E

Undo last action
Ctrl + Z

9. Feedback XE "Feedback" 
We created Stick-e-NotePad to help people take control of their information. As a general goal, we felt it was enough to warrant the development of the program, knowing that when people started using it, they would experiment, and find hundreds of uses we never even thought of. 

We are VERY INTERESTED in hearing about how you are using the program, and how we can make it better. We encourage you to experiment, and let us know how you feel about the product.

Please send comments to:

comments@fusionpointtech.com XE "comments" 
If we adopt an idea of yours to include in our product direction, we would also consider using you or your company as a beta XE "beta testing"  test site during the development of the features. This would give you a FIRST LOOK at the product as it is being developed, and a chance to influence its creation. Sending comments to us places NO OBLIGATION on you to participate in a beta test program, or on us to include you in a program. We will only do so if there is mutual interest & agreement.

If you  XE "referrals" know of a person or organization that you feel would benefit from our products, we hope you will forward our address to them. We will do all we can to earn your trust & confidence and theirs in meeting their information management needs, and we thank you in advance.

http://www.fusionpointtech.com

We at Fusionpoint Technologies sincerely hope that this program makes your life a little easier, and makes some free time for you to spend it on something to enrich your life. That is what it was designed for. Thanks XE "Thank you"  for your support.

Special Thanks are due to the following for making the program a reality:

Elen Lowery for her willingness to learn, her extraordinary skills, and her patience with all the changes.

Nancy & Ted Farinella for their unquestioning support.

Andrew Farinella for his support, and for the sacrificed weekends spent on documentation instead of camping.

Doug VanHook for getting the ball rolling, and always lending a hand wherever possible.

All the guys at Genesis Computers for helping us keep the progress going through all the twists & turns, and for their valuable feedback. (George, Mark, Oscar & Eric)

& Sonny Rath for a great website.
Index
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